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Getting Started

Before you can make calls to an Apple Remote Access MultiPort Server
or other compatible server with Apple Remote Access Client, you must
install the Remote Access Client software on your computer. You must
also connect your computer to a modem and provide Remote Access
Client with information about your modem. This chapter provides
software installation instructions and shows you how to indicate your
modem setup.
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What you need to get started
To use the Remote Access Client software, your computer must be
running Macintosh system software version 7.1 or later (7.5.3 is
recommended) with 4 megabytes (MB) of memory. If you are installing
Remote Access Client software on a PowerPC™-based computer running
the Mac OS, the computer must have at least 8 megabytes of memory.
You also need an appropriate Hayes-compatible modem with a data rate
of at least 2400 bits per second. A 14.4 kilobits-per-second or higherspeed modem is recommended.
Remote Access Client software is fully compatible with Open
Transport, Apple’s new networking software.

Installing Remote Access Client
Your Remote Access Client package includes a 1.44 megabyte (MB)
disk titled Apple Remote Access Client. This disk includes the software
and the Installer program that you use to install the Remote Access
Client software on your computer.
Follow the steps in this section to install the Remote Access Client
software on your computer.
1

Insert the Apple Remote Access Client disk into your floppy disk drive and double-click
the Installer icon to open the program.

The Installer prompts you to identify the software you want to install
and the disk on which you want to install it.
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IMPORTANT If you already have AppleTalk Remote Access 1.0 or Apple
Remote Access Personal Server installed on your computer and you
install Remote Access Client, your computer will no longer be able to
answer calls, even if it was set up to answer calls previously. If you want
to retain your answering capabilities, do not install Remote Access
Client; rather, install the current version of Remote Access Personal
Server software, which will allow you to answer calls as well as make
calls to a Remote Access MultiPort Server.
2

Select the disk on which you want to install Remote Access Client, then click Install.

The installation process begins. The Installer cannot install Remote
Access Client software on your computer if any application programs
are open. If you have programs open, a dialog box appears that gives
you a choice of quitting the open programs and then continuing or
canceling the installation process.
If you have AppleTalk Remote Access 1.0 or Remote Access Personal
Server already installed on your computer, the following alert box
appears, warning you that Remote Access Client will be installed and
your computer will no longer be able to answer calls. If you want to
proceed, click Continue.

When the Installer has finished, a dialog box appears confirming that
the installation was successful.
3

Click Restart to restart your computer.

Installation is now complete. A Remote Access Client folder appears on
the disk directory. This folder contains the Remote Access Client
application and a Read Me file with a list of modems supported by
Remote Access Client. Other components of Remote Access Client
reside in your System Folder.

4

Chapter 1 Getting Started
4

After installing Remote Access Client, go to the Chooser and make sure the Active
button next to the word AppleTalk is selected.

After installing Remote
Access Client, make
sure AppleTalk is active.

Indicating your modem setup
Before your computer can make calls, you need to connect your
computer to an appropriate modem. The Read Me file in the Remote
Access Client folder lists the modems that you can use with Remote
Access Client. Appendix A tells you what to do if your modem isn’t
among those listed. Although you can use a modem capable of
transmitting at least 2400 bits per second, a 14.4 kilobits-per-second or
higher-speed modem is recommended. For information on selecting a
modem cable and connecting your modem to your computer, consult the
manual that came with your modem.
Once you’ve properly connected the modem, follow the steps in this
section to provide the Remote Access Client software with information
about your modem setup. Make sure you’ve already installed the
Remote Access Client software according to the instructions in the
previous section.
Note: If you are installing Apple Remote Access on a Macintosh
PowerBook equipped with an Express modem, see Appendix C, “Using
Apple Remote Access With Macintosh PowerBook Computers.”
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1

Double-click the Remote Access Client icon, which resides in the Remote Access Client
folder, to open the program.

An untitled connection document appears. Ignore it for now; you’ll
work with connection documents in Chapter 2.
2

From the Setup menu, choose Remote Access Setup.

The Modem setup window for Remote Access Client opens, as shown
in the following figure.

Note: Another way to open the Modem setup window for Remote
Access Client is to choose Control Panels from the Apple (K) menu,
then open the Modem control panel.
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3

Choose your modem type from the Modem pop-up menu.

For the most up-to-date list of modems supported by Remote Access
Client, refer to the Read Me file in your Remote Access Client folder.
If your modem doesn’t appear in the menu or in the Read Me file, see
Appendix A for further information.

4

Choose the port to which your modem is connected from the “Connect via” pop-up menu.

If you don’t know which port your modem is connected to, look at the
back of your computer. The modem port has a telephone icon above it;
the printer port has a printer icon.
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5

Choose whether you want the modem speaker on or off by clicking the appropriate button.

6

Choose tone or pulse dialing by clicking the appropriate button.

If you’re dialing from a touch-tone phone line, click Tone. If you’re
dialing from a rotary phone line, click Pulse.
7

Choose whether you want to ignore the dial tone when dialing.

If you’re using a telephone line that does not have a dial tone or that has
a nonstandard dial tone (common in hotels, for example), click the
Ignore Dial Tone checkbox. When this option is selected, Remote
Access Client dials the telephone number without waiting for a dial
tone.
If the telephone line has no dial tone or has a nonstandard
tone and you do not select the Ignore Dial Tone option, Remote Access
Client will not be able to establish the connection.
IMPORTANT

8

If you are connecting over cellular phone lines and you have a modem that supports
MNP 10 error correction, click the “Use MNP 10 error correction in modem” checkbox for
a more reliable connection.

MNP 10 is an error-correction protocol that allows for more reliable
data connections over cellular phone lines. Clicking the “Use MNP 10
error correction in modem” checkbox puts MNP 10 modems into
cellular mode. Do not click the “Use MNP 10 error correction in
modem” checkbox to use MNP 10 over standard phone lines.
To establish a connection using the MNP 10 protocol, both your modem
and the modem you’re calling must support MNP 10; clicking the “Use
MNP 10 error correction in modem” checkbox in the Remote Access
Setup window is not by itself sufficient to establish an MNP 10
connection.
9

Close the Remote Access Setup window.

To return to Remote Access Client, choose the Remote Access Client
application from the Application menu (in the upper-right corner) or
click in a Remote Access Client window.
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Making Calls With Remote Access Client

After you’ve installed Apple Remote Access Client on your computer
and indicated your modem setup, you need to do the following to make
a call to an Apple Remote Access MultiPort Server or other compatible
server:
m Obtain the telephone number of the modem connected to the server
you want to call.
m Obtain the password your network administrator has assigned to you.
Also, check with the network administrator to verify how your name
is indicated on the server, so that you can enter matching information
when you call.
m If the server you’re calling uses the callback option, check that your
telephone number is correctly entered in the server’s records.
m Create a connection document, following the instructions in this
chapter.
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Creating a connection document and connecting to a server
The information that Remote Access Client needs to connect to a server
is stored in a connection document. You can create and save multiple
connection documents, one for each server you need to call. The
following steps describe how to create a connection document and
connect to a server.
IMPORTANT To connect to a server with Remote Access Client, make
sure that AppleTalk is specified as “Active” in the Chooser.
1

Double-click the Remote Access Client icon to open the program (this icon resides in the
Remote Access Client folder).

A new untitled connection document appears.
Note: You can also create a new untitled connection document by
choosing the New command from the File menu.
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2

Click Registered User or Guest.

You can call the server as a registered user or as a guest. When you open
a new connection document, the Registered User button is selected
automatically. Connecting to the server as a registered user means that,
for security reasons, you have been assigned a user name and password
on the server by your network administrator. If you will be connecting as
a guest, click Guest and then go to step 6.
Note: To connect as a guest, the server you’re calling must allow guest
access. Check with your network administrator to find out if you can
connect as a guest.
3

Type your user name in the Name text box, if necessary, then press Tab.

Your user name must match the spelling that is registered with the
server you want to call, but capitalization doesn’t matter.
If you’ve specified an owner name in the Sharing Setup control panel,
the owner name appears automatically in the Name text box. However,
you may need to change the name because it must match the name as it
has been registered on the server.
4

Type your password in the Password text box, then press Tab.

Type your password exactly as it is registered with the server you want
to call. You must match uppercase and lowercase letters exactly. As
you type, each character appears as a bullet (•) to prevent someone else
from reading your password.
Note: If you attempt a connection with an incorrect password, an error
message appears and you can try again. However, as a security
precaution, your network administrator can set a limit on the number of
times you can try to connect. For instance, if the limit is set at seven and
you try to connect using an invalid password seven times consecutively,
the server will revoke your ability to make a connection. In this case,
you’ll need to have your connection privileges reinstated on the server
you’re trying to call. Check with your network administrator if you need
your privileges reinstated.
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5

To save your password in the connection document, click the “Save my password”
checkbox.

If you save your password, you won’t need to enter it whenever you
connect (unless your network administrator has set up the server so you
must always enter a password). However, be aware that this
compromises the security of the server you’re calling, because anyone
can then use your connection document to connect.
6

Type the phone number of the server you want to call in the Number text box.

Enter the number as if you were dialing directly, including the area code
and other numbers you might need, such as a number to get an outside
line or a credit card number.
Depending on your particular calling situation, you may need to insert
one or more commas to separate portions of the phone number, such as
an outside line number, country code, or credit card number. Each
comma causes the modem script to pause 2 seconds before dialing the
rest of the phone number.
As an example, if you’re at a hotel where you must dial 9 to get an
outside line, and you want to call your server at work, and you’re using
a credit card, you might type:
9,0 818-555-1234,credit card number

You can use dashes in the telephone number to make it easier to read,
but Remote Access Client doesn’t require them.
Note: The zero (0) is needed to identify the credit card call.
To automate the dialing process, you may want to use the
DialAssist option, discussed in the next section.
IMPORTANT
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7

Click the Connect button.

When you click Connect, Remote Access Client calls the server and
tries to connect to it. The Remote Access Status window appears and
shows you the progress of your connection. If you want to cancel the
connection attempt before the connection is completed, click the
Cancel button.

The server verifies your name and password, and the connection is then
established.
Note: If the server has callback turned on, you are temporarily
disconnected while the server attempts to call you back. Your phone
will ring, the modem will answer the call, and the connection will be
established.
If you plan on connecting to the server again, you can save the
information in the connection document. See the instructions in the
section “Saving Your Connection Document,” later in this chapter.
IMPORTANT If you try to connect before setting up your modem, the
following alert box appears:

If this alert box appears, click the Setup button and follow the
instructions in Chapter 1 to set up your modem. Then try connecting
again.
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Using DialAssist
DialAssist is a Remote Access Client feature that masks the complexity
of dealing with the worldwide telephone system. It is especially useful
to Remote Access Client users who travel extensively. After you specify
some basic information in the DialAssist setup window, DialAssist
automatically provides portions of a phone number for you—including
numbers to obtain an outside line, long-distance access numbers,
international access codes, country codes, and credit card or calling card
numbers. This means that you don’t have to enter these numbers
manually each time you make a call.
The numbers provided by DialAssist appear in a Dial Preview window
in the connection document, so you can check the entire phone number
before you actually connect.
Follow these steps to set up and use DialAssist:
1

Click the Use DialAssist checkbox in the connection document.

Click here to use
DialAssist.
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The following alert box appears the first time you use DialAssist:

2

Click the Setup button.

The DialAssist setup window appears.
Note: Another way to open the DialAssist setup window is to choose
DialAssist from the Setup menu. Or you can choose Control Panels
from the Apple menu and double-click the DialAssist icon.

Indicate your current location here.

Use these pop-up menus to specify telephone
numbers to get an outside line, a long-distance
carrier (such as AT&T, MCI, or Sprint), and
suffixes (such as calling card numbers).
Use this section to edit the information
in the pop-up menus.

3

Type your current city code or area code in the text box labeled City/Area Code.

By comparing the number you enter here to the area code of the number
you’re dialing, DialAssist can determine whether to append a longdistance access number to the phone number.
Note: If you are calling within a country with no city or area codes, and
you encounter problems using DialAssist, try entering a space in the
“Connect To City/Area Code” box in your connection document.
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4

Choose the country in which you are currently located from the Country pop-up menu.

By comparing your current country to the country you’re calling,
DialAssist can determine whether to append an international access
code (the code for access out of your current country) and country
code (the code for the country you’re calling) to the phone number.
DialAssist automatically adds these codes to the phone number,
if necessary.
If your current country does not appear in the pop-up menu, follow
these steps to add the country and associated country code and
international access code to the menu and to choose the new country:
a. Click the Country button in the Edit portion of the DialAssist setup
window. The Countries dialog box appears.
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b. Click the Add button. The following dialog box appears:

c. Type the country name in the Country text box, type the country code
in the Country Code text box, and type the country’s international
access code in the Access Out text box.
You can obtain the country code and access code by looking in the
phone book or by calling the international operator.
d. Click OK.
You are returned to the Countries dialog box. The country, country
code, and international access code are added to the list and are
highlighted.
e. In the Countries dialog box, click OK.
You are returned to the DialAssist setup window.
f. Choose the country from the Country pop-up menu in the DialAssist
setup window.
Note: You can edit any of the entries in the Countries dialog box by
selecting the entry and clicking the Edit button. Similarly, you can
delete any of the entries using the Delete button.
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5

If you need to add a prefix to your telephone number, for example to get an outside line,
choose this number from the Prefix pop-up menu in the DialAssist setup window.

If the prefix you need does not appear in the pop-up menu, follow these
steps to add a new prefix to the menu and to choose the new prefix:
a. Click the Prefix button in the Edit portion of the DialAssist setup
window. The Prefixes dialog box appears.
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b. Click the Add button. The following dialog box appears:

c. Type a label for the prefix (such as “work”) in the Label text box;
then type the prefix followed by a comma in the Number text box.
d. Click OK.
The Prefixes dialog box appears again. The prefix has been added to
the list and is highlighted.
e. In the Prefixes dialog box, click OK.
You are returned to the DialAssist setup window.
f. Choose the prefix from the Prefix pop-up menu in the DialAssist
setup window.
Note: You can edit any of the entries in the Prefixes dialog box by
selecting the entry and clicking the Edit button. Similarly, you can
delete any of the entries using the Delete button.
6

If you’re making a long-distance call, choose your long-distance carrier from the Long
Distance Access pop-up menu in the DialAssist setup window.
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DialAssist automatically provides the long-distance access number
associated with your carrier. (This number will appear in the Dial
Preview portion of the connection document.) If your long-distance
carrier does not appear in the pop-up menu, follow these steps to add it
to the menu and to choose the new carrier:
a. Click the Long Distance button in the Edit portion of the DialAssist
setup window. The Long Distance Access dialog box appears.

b. Click the Add button. The following dialog box appears:

c. Type a label for your long-distance carrier in the Label text box; then
type the long-distance access number in the Number text box. (You
can obtain the access number from your long-distance carrier.)
d. Click OK.
You are returned to the Long Distance Access dialog box. The longdistance carrier and access number have been added to the list and are
highlighted.
e. In the Long Distance Access dialog box, click OK.
You are returned to the DialAssist setup window.
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f. Choose the long-distance carrier from the Long Distance Access popup menu in the DialAssist setup window.
Note: You can edit any of the entries in the Long Distance Access
dialog box by selecting the entry and clicking the Edit button. Similarly,
you can delete any of the entries using the Delete button.
7

If you need to add a suffix to your telephone number, such as a credit card or a calling
card number, click the Suffix button in the Edit portion of the DialAssist setup window.

The Suffixes dialog box appears, as shown in the following figure. The
entries in this dialog box are simply placeholders; you can either edit
these placeholders or add a new entry. The following steps describe how
to edit the placeholders to enter your own credit card or calling card
number, or other suffix.
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a. With the label My Credit Card highlighted, click the Edit button. The
following dialog box appears:

b. Type a label for your suffix (such as “MCI credit card”) in the Label
text box; then type the numbers for your suffix in the Number text
box.
c. Click OK.
The Suffixes dialog box appears again. The suffix you edited is
highlighted. For security reasons, each number you entered in the
Number text box appears as a bullet (•).
d. In the Suffixes dialog box, click OK.
You are returned to the DialAssist setup window.
e. Choose the suffix from the Suffix pop-up menu in the DialAssist
setup window.
Note: You can add a new entry to the Suffixes dialog box by using the
Add button. You can delete any of the entries by selecting the entry and
using the Delete button.
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8

Once you’ve specified all the appropriate setup information in the DialAssist setup
window, reactivate your connection document by clicking in it.

Your connection document now contains a text box for City/Area Code
and a Country pop-up menu for choosing the country you want to
connect to, as shown in the following figure. In addition, the Dial
Preview portion of the connection document reflects the settings you
chose in the DialAssist setup window. Note that for security reasons, the
suffix information (which could contain your credit card or calling card
number) is identified by label only, rather than by the actual number.

Enter the city/area code of the
server you’re calling here.

9

In the City/Area Code text box in the connection document, type the city code or area
code of the server you’re calling.

If the city or area code you’re calling is different from your current city or
area code, DialAssist adds this city or area code to the telephone number.
In addition, DialAssist adds your long-distance access number to the
phone number. The city or area code and long-distance access number
appear in the Dial Preview portion of the connection document.
Note: If you already have a city code or area code in the Number text
box, make sure you delete it and enter it in the City/Area Code text box.
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10

From the Country pop-up menu in the connection document, choose the country you’re
calling.

If you are calling another country, DialAssist automatically adds the
appropriate international access code and country code to the phone
number. These codes appear in the Dial Preview portion of the
connection document, as shown in the following figure.

Use this pop-up menu to specify
the country you’re calling.

Long-distance Access Country City code
access number code
code
(for Paris)
(MCI)
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If the country you’re calling does not appear in the pop-up menu,
follow these steps to add the country (and its associated country code
and international access code) to the pop-up menu and to choose
the country:
a. Open the DialAssist setup window by clicking the Setup button in
the connection document or by choosing DialAssist from the
Setup menu.

b. Click the Country button in the Edit portion of the DialAssist setup
window. The Countries dialog box appears.
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c. Click the Add button. The following dialog box appears:

d. Type the country name in the Country text box, type the country code
in the Country Code text box, and type the country’s international
access code in the Access Out text box.
You can obtain the country code and access code by looking in the
phone book or by calling the international operator.
e. Click OK.
You are returned to the Countries dialog box. The country, its
associated country code, and international access code are added to
the list and are highlighted.
f. In the Countries dialog box, click OK.
You are returned to the DialAssist setup window.
g. Click in your connection document to reactivate it.
h. Choose the country from the Country pop-up menu in the connection
document.
11

To connect to the server, click the Connect button in the connection document.

Remote Access Client dials the telephone number as it appears in the
Dial Preview portion of the connection document.
Note: The Dial Preview portion of the connection document cannot be
edited. If you need to change any part of the telephone number that
appears there, go back to the DialAssist setup window (click the Setup
button in the connection document or choose DialAssist from the Setup
menu) or change the appropriate information in the Connect To portion
of the connection document.
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Specifying connection document options
Each connection document includes an Options button that enables you
to specify Remote Access Client preferences for redialing choices and
connection reminders. You may have additional options if your network
administrator has installed special software in your Extensions folder.
See the section “Some Additional Options” later in this chapter for
more information.

Specifying preferences
The Preferences option allows you to specify
m whether you want Remote Access Client to redial a busy telephone
number when calling a server or to dial both the main number
(specified in the connection document) and an alternate phone
number if the main phone number is busy
m whether you want Remote Access Client to remind you of your
connection, to avoid unintentional or prolonged connections
Follow these steps to choose the redialing option and to instruct Remote
Access Client to remind you of your remote access connection:
1

With a connection document open, click the Options button.

The Options dialog box appears.
2

If the Preferences option is not already selected, choose it from the Options pop-up menu.

The Preferences options appear.
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3

Choose one of the redialing options from the Redialing pop-up menu.

You can choose to redial the main phone number that you typed in the
connection document or both the main number and an alternate number.

4

Type the number of times you want Remote Access Client to redial the telephone
number (or numbers) and indicate the amount of time you want to elapse between
redials (in seconds).

You can specify that the number (or numbers) be redialed up to 1000
times. Set the “Time between retries” number to five seconds or greater.
Anything less than five seconds may not give your modem sufficient
time to reset, so the serial port may be busy and unavailable for
redialing. The maximum time between retries is 1000 seconds.
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5

If you want Remote Access Client to redial an alternate phone number, type the number
in the Number text box.

Follow the same conventions you used for the main telephone number.
(For more details, see the section “Creating a Connection Document
and Connecting to a Server” at the beginning of this chapter.)
Note: If you are using DialAssist, you will see an additional text box in
which you type the city code or area code.
Remote Access Client first dials the main number. If that number is busy,
Remote Access Client dials the alternate number, and then switches
between the main number and alternate number until a connection is made
or until the number of redials you have specified is reached.
Note: Redialing only occurs if the connection fails because the number
dialed is busy. If the connection attempt fails for any other reason,
Remote Access Client stops redialing so that you can correct any
problems.
6

If you want Remote Access Client to remind you of your connection, choose whether you
want the reminder to be a flashing icon, an alert box that is displayed after a certain
interval, or both.

If you choose to be reminded by means of a flashing icon, you will see
the Remote Access Client icon flashing in the Apple menu after you are
connected.
If you choose to be reminded after a certain interval by a dialog box,
type a number between 1 and 1000 after the Display Alert Every
checkbox. This number tells Remote Access Client how often, in
minutes, to remind you of the connection.
After your computer is connected to a server for the specified period of
time, you will receive a message asking if you want to continue your
connection. If you click OK, your work will not be interrupted. If you
do not respond within one minute, Remote Access Client will
disconnect you.
7

Click OK.

The preferences you specified are now in effect.
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Some additional options
Your network administrator may install additional software in your
Extensions folder that will allow you to choose these additional options:
m If an X.25 extension is installed, you can specify whether you want
to make a remote connection to a Remote Access MultiPort Server
through an X.25 network.
m If a Remote Access MultiPort Server is running non-Apple security
software, you must select the Security option and indicate your
security type in order to gain access to your server.
These two options are described in the following sections.
Using the Connection option
Follow these steps to make your remote connection to a Remote Access
MultiPort Server through an X.25 network:
1

With a connection document open, click the Options button.

2

If it is not already selected, choose Connection from the Options pop-up menu.

The Connection option appears.
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3

Choose X.25 Service from the “Connect through” pop-up menu.

4

Choose your X.25 network provider from the Network pop-up menu.

The network provider names that appear in the pop-up menu correlate to
the network provider scripts that your network administrator placed in
your Extensions folder.
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5

Enter the information required for your network provider.

The text boxes that appear in the Connection section of the dialog box
are determined by the network provider you choose.
You may have to enter the X.25 network address of your Remote
Access MultiPort Server, supply a network user ID or the name of your
closed user group, or specify whether you want the charges for your call
reversed. An example is shown in the following figure.

6

Click OK.

You are returned to your connection document. When you click the
Connect button, Remote Access Client establishes a dial-up X.25
connection with the connection options you have specified.
Using the Security option
If your network administrator has installed a security device on your
Remote Access MultiPort Server, you must specify security information
in order to access the server. Follow these steps to specify security
information:
1

With a connection document open, click the Options button.
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2

If it is not already selected, choose Security from the Options pop-up menu.

The Security option appears.

3

Choose the appropriate security module from the “Security type” pop-up menu.

Security software is installed and maintained by your network
administrator. Contact your administrator if you need information about
what security software to select.
4

Click the Configure button if it is highlighted.

Select the options presented by your security module.
5

Click OK.

You are returned to your connection document.

Saving your connection document
When you save the connection document, you won’t have to reenter the
information the next time you call the same server; you’ll only need to
open the connection document and click Connect. To save the
connection document, follow these steps:
1

With your connection document open, choose Save or Save As from the File menu.

2

Enter a name for the connection document and click Save.

Choose a name that describes the server you’re calling, like “Boston
Office.” You can store connection documents wherever you like on your
hard disk.

34

Chapter 2 Making Calls With Remote Access Client

Changing or deleting connection information
After you’ve saved a connection document, double-click its icon to open
it. You can edit any of the information previously entered and save the
connection document for later use.
To get rid of a connection document, drag it to the Trash and use the
Empty Trash command in the Finder to delete it.

Dialing manually
There may be times when you want to dial manually rather than have
Remote Access Client place the call. For example, you may want to
make an operator-assisted call. Note that you must have a telephone
attached to your modem in order to place a manual call. To dial
manually, follow these steps:
1

If necessary, open the Remote Access Client program and the appropriate connection
document.

To dial manually, you must specify your user name and password in the
connection document. You do not need to enter the phone number of the
server you’re calling.
2

Choose Manual Dialing from the Setup menu.

The following dialog box appears:

3

Attach the phone handset to your modem.
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4

Dial the server’s telephone number or have an operator place the call. Click Connect.

Note: Different modems connect in different ways. You may need to
experiment with pressing the Connect button just before or just after
you hear the remote modem answer the phone.
5

Hang up the phone.

You are now connected to the remote server.

Other ways to connect to a remote server
Another way you can open the Remote Access Client program is to drag
a connection document onto the Remote Access Client icon.

This opens both the Remote Access Client program and the connection
document. You then enter your password (if necessary) and click the
Connect button to call the server specified in the connection document.
As a shortcut, hold down the Command (x) key when double-clicking
the connection document or when dragging the connection document
onto the Remote Access Client icon. The Remote Access Client
program prompts you for your password (if necessary) and then tries
to connect to the remote server using that connection document.
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Connecting automatically
Once you’ve created a connection document, you can connect
automatically to a shared volume on a remote server by creating an
alias. (For a detailed discussion of aliases, refer to your system software
documentation.) By double-clicking an alias, you can establish a
connection without opening the Remote Access Client application. To
create an alias for a remote server, follow these steps:
1

Connect to a remote server using the procedures described in the section “Creating a
Connection Document and Connecting to a Server,” earlier in this chapter.

2

Using the Chooser, mount the server volume of the remote network that you’ll want to
connect to later using an alias. If you need more information on mounting volumes from
the chooser, refer to your system software documentation.

3

Select the server volume icon.

4

Choose Make Alias from the File menu.

An alias icon appears that has the name of the volume with the word
alias appended to it. (You can change the name if you want to.) The
alias is already selected.
5

Choose Get Info from the File menu.

6

Click the Locked checkbox.

If you don’t lock the alias, the alias may accidentally be converted to
call the wrong Remote Access server.
7

Drag the alias to a convenient place on your desktop or disk.

8

When you’re done using the volume, disconnect from it by dragging its icon to the Trash.

Notice that you still have an active Remote Access Client connection.
To disconnect from Remote Access Client, see the section
“Disconnecting From a Remote Server,” later in this chapter.
9

The next time you want to make a connection to that remote server, double-click the alias.

A dialog box appears showing you the status of your connection. To
cancel the connection attempt before the connection is completed, click
the Cancel button.
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Selecting remote network services
With Remote Access Client, you can simultaneously use the services of
your local AppleTalk network as well as the services of the server
you’ve called. Once you’ve established a connection to a remote
AppleTalk network, you can select network services in the Chooser
window or use other network products, such as electronic mail,
following the same steps you would take to use the services on your
local network.
Note: If you want to connect to a remote computer after calling a
server, make sure that file sharing is turned on for the remote computer.
For more information about file sharing, talk to your network
administrator or refer to your System 7 documentation.
As an example, the following discussion illustrates how to print to a
LaserWriter that’s on a remote AppleTalk network while you’re still
connected to your home LaserWriter. Let’s say you have not yet used
Remote Access Client to connect. Assuming that your computer has an
AppleTalk network printer such as a LaserWriter attached, the list of
local services available to you, which appears in the Chooser, would
look something like this:
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Once you’ve used Remote Access Client to call the server and
established a connection with the remote AppleTalk network, the
services available on the remote network will also appear in the
Chooser, as shown in the following figure. You can select the zone (if
there are zones) and services you want on the remote network.

Changing your password
Once you are connected to a remote server, you can change your
Remote Access Client password as described in the following steps.
Note: Contact your network administrator to find out if AppleShare is
installed on the same server as your Remote Access server. If so, your
new Remote Access Client password will also be your AppleShare
password.
1

Establish a connection to a remote server using the procedures described in the section
“Creating a Connection Document and Connecting to a Server,” earlier in this chapter.
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2

Choose Change Password from the Setup menu.

The Change Password dialog box appears.

3

Type your current password in the text box labeled “Old password.”

A bullet (•) appears for each character you type.
4

Type a new password in the text box labeled “New password.”

A bullet (•) appears for each character you type. Use a password that
will not be easily guessed by someone else.
5

In the text box labeled “Retype new password,” type the new password again to verify it;
then click OK.

The following dialog box appears:

6

Click OK.

Your password has been changed.
After you’ve changed your password, be sure to update each
of your connection documents in which you selected the “Save my
password” option.
IMPORTANT
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Viewing your connection status
Whenever the Remote Access Client program is open, you can
view your connection status by looking at the Remote Access Status
window. To open the window, choose the Status command from the
Windows menu.

The Remote Access Status window appears, showing details of your
connection.

The Remote Access Status window tells you where you’re connected
and how long you’ve been connected. The window also shows you the
time remaining for your connection. The time limit is set by the network
administrator of the server you’ve called. If you have no time limit for
your connection, the time remaining is indicated by the word Unlimited.
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Connecting efficiently
Remember that when you use Remote Access Client, you are using
standard telephone lines to connect to a server. If you call a server
outside your local calling area, you will be billed for any toll charges
or long-distance charges.
The following guidelines can help keep your long-distance phone
charges to a minimum:
m Do not open applications such as word processors, spreadsheets, and
graphics programs on the remote network. Because the program will run
over telephone lines, commands may take an extraordinarily long time
to complete.
m Prepare files as much as possible before you make a connection. For
example, if you need to write a cover memo for your file, do it before
connecting to the remote server.
m Use the Connection Reminder option. This keeps you from forgetting
that you are connected and inadvertently running up your phone bill.
m While you’re using file server volumes, don’t leave their windows
open. These windows are updated periodically, causing unnecessary
network traffic.
m As soon as you finish using a file server volume, disconnect from the
server.
Note: If the server you’re calling has the callback option turned on, it
disconnects your call and immediately calls you back. The server then
originates the phone connection and becomes responsible for the charges.

Using the Activity Log
The Activity Log automatically documents all Remote Access Client
events. It keeps track of when a Remote Access Client connection is
attempted, established, or disconnected. The Activity Log retains the
1000 most recent Remote Access Client activities. Follow these steps to
view the Activity Log:
1

Make sure the Remote Access Client program is open.

2

From the Windows menu, choose Activity Log.
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The Activity Log appears, displaying the current and most recent
activity on your computer. The first column shows the date and time of
the activity. The second column displays the name of the user making
the call. The third column describes the activity.

Copying, saving, and clearing the Activity Log
To save the Activity Log for your records, you can select the Activity
Log entries and copy them to the Clipboard. Click the entry, Shift-click
the range of entries you want to copy, or use Select All from the Edit
menu; then use the Copy command from the Edit menu.
The entries are copied to the Clipboard as tab-delimited text, so you can
paste them into a spreadsheet file. You can use this spreadsheet file to
save multiple records of the Activity Log, to sort and search through the
information, or to print the log.
You can also save the Activity Log as a text file. To do this, choose Save
As from the File menu. You’ll be prompted to enter a name for the text
file, which is saved on the disk you specify. By default, the text file is
saved under the name Log, followed by a range of dates that correspond
to the earliest and latest activities in the Activity Log. Use any wordprocessing or spreadsheet program to view or edit the text file.
If you want to clear the Activity Log, choose Clear Log from the Edit
menu. A dialog box appears, prompting you to confirm that you want to
clear the Activity Log. After you clear the Activity Log, those entries
cannot be recovered, so you should save the log before clearing it.
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Using the Remote Only option
When Remote Access Client is installed, the Network control panel
contains an additional icon called Remote Only, shown in the following
figure. You use the Network control panel to select the type of network
to which you want to connect. For more information, refer to your
computer’s manual or your system software documentation.

You might select Remote Only for three reasons:
m To turn off access to your local AppleTalk network (LocalTalk,
EtherTalk, or TokenTalk), so you see only the remote network when
you make a Remote Access Client connection.
Sometimes you can’t locate a service on the remote network because
a service on your local network has the same address. This is similar
to phone numbers, for which two people in different area codes may
have the same seven-digit phone number. If you don’t specify the
area code and dial only the seven-digit number, you call the person
who is in the same area code as you. Selecting Remote Only is like
dialing the area code, meaning you call the person outside your local
area. When you select Remote Only, access to the local network is
shut off, ensuring that all services on the remote network are
accessible.
m To turn off LocalTalk (which uses the printer port on your computer)
and free up the printer port for local printing while you use Remote
Access Client.
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m To use the Remote Access Client software on a computer with only

one serial port.
Computers with a single serial port include the Macintosh PowerBook
5200 and 190, and the Macintosh Performa 6200 series. If you are
using an external modem, you need to specify Remote Only because
there is no available serial port to connect to the local network.
Note: Be aware that if your computer is currently connected to a remote
network and you switch from one AppleTalk connection type to another
in the Network control panel, such as from LocalTalk or EtherTalk to
Remote Only, you will be disconnected. However, you can always
reconnect.
With LocalTalk, EtherTalk, or TokenTalk selected
Local network

Remote network

Your computer can access all devices
on the local and remote networks.

With Remote Only selected
Local network

Remote network

Your computer can access all devices
on the remote network only.

Disconnecting from a remote server
There are two ways to disconnect from a remote server: choosing
Remote Access Disconnect from the Apple menu or clicking the
Disconnect button in the Remote Access Status window. These two
methods are discussed in the following sections.
When you disconnect from a remote server, the Remote Access Client
program is still open, so you can make another connection or create a
new connection document.
Note: If you shut down your computer while it is connected to a remote
server, the connection is automatically broken.
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Using Remote Access Disconnect
When you install Remote Access Client, a file called Remote Access
Disconnect is installed in your Apple menu.

You can quickly disconnect from a remote server by choosing Remote
Access Disconnect from the Apple menu. A dialog box appears asking
you to confirm that you want to disconnect; simply click OK, and the
connection is broken.

Using the Disconnect button
To disconnect from a remote server using the Disconnect button, follow
these steps:
1

Make sure the Remote Access Client program is open.

2

From the Windows menu, choose Status.

The Remote Access Status window appears.

3

Click the Disconnect button.

The connection is broken.
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Quitting the Remote Access Client program
You can quit the Remote Access Client program by choosing the Quit
command from the File menu. Quitting the program frees up memory
for your computer to use for other processing.
If you quit while you’re connected to a remote server, the following
dialog box appears, reminding you of your connection. You can choose
to disconnect and quit, stay connected and quit, or cancel.

Note: You’ll need to reopen the program if you want to open a
connection document or check your connection status in the Remote
Access Status window. If you reopen the program while a connection is
active, the Remote Access Status window automatically opens.
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Apple Remote Access Client includes scripts (programs that can run
automatically) that make it possible for you to use many popular Hayescompatible modems. (Hayes Microcomputer Products, a major
manufacturer of modems, developed a language for controlling modems
that has been widely adopted. Any modem that recognizes Hayes modemlanguage commands is said to be Hayes-compatible.)
Each modem script contains program code used by the Remote Access
Client software to communicate with that particular modem type. For the
most up-to-date list of modems that have scripts included with the
Remote Access Client software, refer to the Read Me file in the Remote
Access Client folder on your hard disk.
This appendix discusses what you can do if the script for your modem is
not included with the Remote Access Client software. In addition, this
appendix covers modem cable requirements, describes how to connect a
typical modem to a typical computer running the Mac OS, and lists
standard modem commands.

48

Appendix A Using Modems With Remote Access Client

If a script for your modem is not included
Your modem should conform to the ITU-TS (International
Telecommunication Union-Telecommunication Standardization sector,
formerly the CCITT) standards V.22bis, V.32, or V.32bis. If you want to
use Remote Access Client with a modem not listed in the Read Me file in
the Remote Access Client folder, check with one of the following sources
to see if a modem script is available:
m your modem vendor
m your Apple-authorized dealer or service provider
m the Apple Customer Assistance Center (call the support number listed
in the support information provided with your Apple Remote Access
Client software)
m the Apple Web site (http://www.apple.com)
m the Apple Technical Coordinator Answerline or the Apple Software
Development Answerline (you must be a subscriber to these services
to receive assistance from them.)
Some modems for which scripts are not included with the Remote
Access Client software may need a cable that supports the Clear To
Send (CTS) protocol. See “Modem Cable Requirements,” later in this
appendix, or call the Apple Customer Assistance Center for more
information.
All modem scripts must be placed inside the Modem Scripts
folder, which is inside the Extensions Folder, which is inside the System
Folder. Scripts placed in any other location won’t work.
IMPORTANT
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Writing modem scripts
If you understand Communication Command Languages (CCLs) and are
an experienced programmer, you may be able to write the necessary
modem script yourself. The Apple Remote Access Modem Toolkit
Version 2.0 includes a HyperCard stack and appropriate documentation
to help you build scripts.
You can obtain the Modem Toolkit at no charge from ftp.info.apple.com
or ftp.support.apple.com, or via AppleLink, America Online, or
CompuServe. From whatever source you use, you can find the Toolkit
on the following path:
Apple Software Updates
US or Worldwide
Macintosh
Networking and Communications
Apple Remote Access
Other ARA
The Modem Workshop and its associated documentation are provided in
a self-extracting archive entitled ARA Modem Toolkit.sea. The
documentation is in Adobe™ Acrobat™ format.
You can also order the toolkit through the the Apple Developer Catalog.
For a free catalog or to order the kit, contact
Apple Developer Catalog
Apple Computer, Inc.
P.O. Box 319
Buffalo, NY 14207-0319
800-282-2732 (United States)
800-637-0029 (Canada)
716-871-6555 (International)
Fax: 716-871-6511AppleLink: ORDER. ADC
Internet: order.adc@applelink.apple.com

50

Appendix A / Using Modems With Apple Remote Access Client

Connecting your modem
How you set up your modem depends on the type of modem you’re
using. For specific details on how to connect your modem to your
computer, refer to the documentation that came with your modem.
Depending on the type of modem and computer you use, you’ll need to
do the following:
m Connect your modem to your telephone line.
m Connect your modem to your telephone (optional).
m Connect your modem to your computer.
m Connect a power supply to your modem.
Modem

Computer

To power supply
To computer
To telephone line
To telephone (optional)

Modem cable requirements
Most modems require a cable that supports the data terminal ready
(DTR) signal. Certain modems require a cable that also supports clear to
send/ready to send (CTS/RTS or just CTS) hardware flow control. To
support DTR, the cable must connect pin 20 on the DB-25 connector to
pin 1 on the Mini DIN-8. To support CTS/RTS, the cable must connect
pin 5 on the DB-25 connector to pin 2 on the Mini DIN-8 and pin 4 on
the DB-25 connector to pin 1 on the Mini DIN-8. Contact your modem
manufacturer or your Apple-authorized dealer or service provider to
obtain the necessary cable.
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Modem commands
Most modems available in the United States can interpret standard
commands. You enter these commands as characters in the telephone
number sent to the modem. The following table lists standard
commands, but you should refer to your modem manual for a complete
description of the commands it interprets.
Command
(character)
0–9, #, *
T
P
,

Function
Characters used for dialing
Causes all digits following to be touch-tone dialed
(the default)
Causes all digits following to be pulse dialed
Pauses before continuing

Touch-tone and pulse dialing
Remote Access Client enables you to specify whether you’re dialing
from a touch-tone or a rotary (pulse) phone by choosing the appropriate
button in the Modem setup window for Remote Access Client. (Choose
Remote Access Setup from the Setup menu to display this window.) As
an alternative to using the buttons in this window, you can precede the
telephone number with a T (for touch-tone) or a P (for pulse), as shown
here:
P1,818-555-1234

If you need a combination of pulse and touch-tone, precede the numbers
with P (for pulse) and T (for touch-tone) as appropriate. You may need
to do this if you’re making a long-distance call with pulse dialing and
you first connect to your long-distance carrier and then enter an access
code using touch-tone. In this case, the phone number you enter should
look something like this:
P1,818-555-1234 T342
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This appendix discusses potential problems you may encounter while
using Remote Access Client and offers suggestions for solving these
problems. If these suggestions do not solve your problems, call the
Apple Assistance Center, using the number supplied in the support
information provided with your software. You can also find support
information on the World Wide Web at http://www.apple.com.
You can’t make a call.

m Make sure your modem is connected properly and turned on. Refer to

your modem documentation if you have any problems.
m Make sure your modem type and port are correctly selected in the
Modem setup window.
Your modem is working, but you can’t connect to the server.

m Make sure you’re a registered user on the server or that the server is

m
m
m
m

set up for guest access. If you try to connect as a registered user,
check that you’ve entered your user name and password correctly.
Make sure that AppleTalk is specified as “Active” in the Chooser.
Make sure that the server and its modem are turned on, and that it is
set up to answer calls.
Find out if the server is set up to call you back, and verify that the
telephone number registered on the server is correct.
You may need to add one or more commas at breaks in the telephone
number, such as after the area code or country code, so that the
modem script pauses longer before dialing succeeding portions. (See
the section “Creating a Connection Document and Connecting to a
Server” in Chapter 2 for information about dialing.)
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m AppleTalk may be assigned to a port to which you’ve connected your

external modem. Open the Network control panel and click the
Remote Only icon.
m If you’re calling a Remote Access MultiPort Server that has
additional security features implemented, you may not have the
appropriate security module installed in your Extensions folder. See
your network administrator.
You’re using an X.25 connection and your connection attempts are failing.

m Make sure your server is properly set up to receive X.25 calls.
m Make sure you have selected the correct network and network address

in the Connection dialog box.
m X.25 does not support the callback feature. If an alert box appears
warning you that your connection attempt has failed because callback
is not supported, check with your network administrator to ensure
that the callback feature is disabled for your account.
m If the problem persists, contact your X.25 network provider.
You are losing the connection.

m You may have noisy phone lines. Contact your phone company.
m Make sure you’ve selected the correct modem type in the Modem

setup window.
m If you have a call-waiting feature on your phone, an incoming call
can disrupt the connection. Contact your phone company for
information on what code to use to turn off call waiting. When you
enter the phone number in the connection document, precede the
number with the code to turn off call waiting.
The response time from the remote network is slow.

m If you have been using a 2400-bps modem, consider upgrading to a

9600-bps or higher-speed modem.
m Refer to the section “Connecting Efficiently” in Chapter 2 to see if
you can save time during the connection.
m If you’ve connected to a server via X.25, performance may vary
according to the load on the X.25 network.
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You are left waiting for a callback from the server.

m After you make an initial connection with a server, you are

disconnected, but the callback never occurs. Check with your
network administrator to verify that your callback number is correct.
You can’t locate a service on the remote network.

m If a service on the remote network has the same name as a service on

your local network, you may not be able to find the remote service
you’re looking for. To see the remote service, change your network
connection to Remote Only in the Network control panel. Refer to the
section “Using the Remote Only Option” in Chapter 2 for more
information.
After you connect to a remote network, you have problems with your ImageWriter or
another device connected to the printer port.

m Change your network connection from LocalTalk (or EtherTalk or

TokenTalk) to Remote Only in the Network control panel to redirect
AppleTalk and allow you to print to your serial printer. Refer to the
section “Using the Remote Only Option” in Chapter 2 for more
information.
After you connect to a remote network, you cannot access your local network.

m Change your network connection from Remote Only to LocalTalk (or

EtherTalk or TokenTalk) in the Network control panel to access your
local network. Refer to the section “Using the Remote Only Option”
in Chapter 2 for more information.
Other programs that use the serial port don’t function properly, you see a dialog box that
says the serial port is in use, or your Macintosh freezes during shutdown.

m Remove the Serial Port Arbitrator from the Extensions folder in the

System Folder and restart your computer. (You may want to create a
folder in your System Folder called Disabled Extensions and move
the Serial Port Arbitrator to this folder in case you need it in the
future.)
m If another program is incompatible with Remote Access Client,
contact your Apple-authorized dealer or service provider for more
information.
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A modem script does not appear in the Modem pop-up menu in the Remote Access
Setup window.

m Make sure that the modem script is installed in the Modem Scripts

folder, inside the Extensions folder, inside the System Folder. Some
modem scripts are set to install into the Extensions Folder itself. You
need to move such scripts into the Modem Scripts folder.
m Contact the modem manufacturer to make sure the modem script is
compatible with Remote Access Client. Modem scripts for other
applications, such as AppleLink, will not work with Remote Access.
Some modem features, such as manual dialing, do not work.

m Contact the modem manufacturer to be sure the modem script has

been upgraded to support the new features available with Remote
Access Client version 2.0.
The computer crashes, or other problems occur, when the Remote Access Client
software is installed on a computer that is running the Mac OS with Virtual Memory.

m Do the following:

1. If you have not already done so, install the Serial Switch control
panel from the Apple Remote Access Client installation disk.
2. Open the Serial Switch control panel.
3. Set the serial port to Compatible.
The computer crashes when using an Express or GeoPort modem.

m Open the Memory Control Panel and turn on 32-bit addressing.
An Activity Log file won’t print properly.

m Do the following:

1. Choose Page Setup from the File menu.
2. Click the Landscape (horizontal) icon in the Orientations section of
the dialog box.
3. Enter 70% in the Reduce or Enlarge box.
4. Click OK.
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If you are installing Apple Remote Access Client on a PowerBook computer with
an Express Modem or another internal modem of any type, you will need to be
aware of the special instructions covered in this appendix.
Disregard this appendix if you are using a newer PowerBook with a PCMCIAbased internal modem. In that case see the Apple Remote Access section of
your computer’s user guide.

Using Remote Access Client on a PowerBook with an Express Modem
This section provides answers to some common problems that may arise with
Express Modem use.

Freezing in sleep mode
If your PowerBook freezes when it goes to sleep while a Remote Access Client
connection is active, check your Express Modem software. If the software is
earlier than version 1.1, upgrade it to version 1.1 or later. This should solve
the problem.

58

Appendix C Using Remote Access With Macintosh PowerBook Computers

Changing to an external modem
If you want to change from your Express Modem to an external modem,
follow these instructions:
1

If your PowerBook computer has only one serial port, open the Network control panel
and click Remote Only.

2

With the Modem setup window closed, open the PowerBook control panel and click the
External Modem button.

The External Modem button won’t be active if the Modem setup window
is open.
3

From the Setup menu in Remote Access Client choose Remote Access Setup to open
the Modem setup window.

4

Select the appropriate serial port in the “Connect via” pop-up menu.

5

Connect the external modem to the selected port.

Removing the Serial Port Arbitrator
Disregard the section in the Express Modem Read Me file that tells you to
remove the Serial Port Arbitrator from the Extensions folder in your System
Folder. Remove the Serial Port Arbitrator only if it is causing problems (for
instance, other programs that use the serial port don’t function properly, or you
see a dialog box that says the serial port is in use when it is not).

Using Remote Access Client on a PowerBook with an internal modem
To use Remote Access Client on a PowerBook with an internal modem, you need
to specify the modem script and serial port in the Modem setup window and the
modem type in the PowerBook control panel. Follow these instructions:
1

From the Setup menu in Remote Access Client choose Remote Access Setup to open
the Modem setup window.

2

In the Modem setup window, choose the correct modem script for your modem from the
Modem pop-up menu and choose Internal Modem from the “Connect via”
pop-up menu.

3

In the PowerBook control panel, click the Internal Modem button.
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Preface

Apple Remote Access Client is software that lets a computer running
the Macintosh operating system (Mac OS) communicate with an Apple
Remote Access MultiPort Server or other compatible server over
standard telephone lines, giving you convenient and direct access to
information and resources at a remote location. For example, if you’re
at home but need to get a file from your computer at work, Remote
Access Client can make the connection to your office server. Once
you’re connected to the server, you can use Macintosh file sharing to
access files on your office computer or any other computer on the same
network as the server.
Remote Access Client lets you go beyond using just the resources of
one computer—once you’ve connected to a server that is on an
AppleTalk network, you can take advantage of all the services available
on the remote network. For example, you can check your electronic
mail, access files on AppleShare file servers, print to a LaserWriter
printer on the network, or even access your company mainframe.
The Apple Remote Access MultiPort Server is a computer on the
network that has special software that manages incoming calls. Your
network administrator is responsible for setting up this server. In
addition to calling an Apple Remote Access MultiPort Server (or other
compatible server), you can use Remote Access Client to call a
computer that has Apple Remote Access Personal Server installed.
Remote Access Personal Server enables a computer to answer as well as
make calls.
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Remote Access Client lets you access services
such as electronic mail, file sharing, file service,
and printing remotely.

Calling

Answering

About this guide
This guide explains how to install and use the Apple Remote Access
Client software. Chapter 1 tells you what you need to get started,
provides you with instructions on how to install the software, and
describes how to indicate your modem setup. Chapter 2 provides stepby-step instructions for using Remote Access Client to call a server.
Appendix A provides information on using modems with Remote
Access Client. Appendix B contains troubleshooting suggestions.
Appendix C provides tips about using Remote Access with PowerBook
computers.
This guide assumes that you are already familiar with the Mac OS
desktop as well as with basic Mac OS skills, such as using the mouse
and the Chooser. If you’re unfamiliar with these skills, refer to the
manuals that came with your computer.
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You should also understand basic networking concepts and have
experience using network services like electronic mail, file servers, and
printers. For more information on the networking features of your
computer, see the networking chapter in the manual for your computer
or in your System 7 documentation.

On-screen help
Remote Access Client includes two sources of on-screen information that
you can consult when you need help: Balloon Help and Remote Access
Information.
Balloon Help is a feature of System 7 that explains the function or
significance of items you see on your screen. To turn on Balloon Help,
pull down the Help menu from the Help icon (the question mark) near
the right end of the menu bar, and choose Show Balloons. When you
point to an item on your screen, a balloon with explanatory text appears
next to the item. To turn off Balloon Help, choose Hide Balloons from
the Help menu.
You can also choose Remote Access Information from the Help menu.
Remote Access Information provides you with a series of on-screen
cards that explain how to use Remote Access Client.

